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提供本文档的中文版本仅为了便于理解。请勿忽视文档中包含

的英文部分，因为其中提供了有关 Microchip 产品性能和使用

情况的有用信息。Microchip Technology Inc. 及其分公司和相

关公司、各级主管与员工及事务代理机构对译文中可能存在的
任何差错不承担任何责任。建议参考 Microchip Technology
Inc. 的英文原版文档。

本出版物中所述的器件应用信息及其他类似内容仅为您提供便

利，它们可能由更新之信息所替代。确保应用符合技术规范，

是您自身应负的责任。Microchip 对这些信息不作任何明示或

暗示、书面或口头、法定或其他形式的声明或担保，包括但不

限于针对其使用情况、质量、性能、适销性或特定用途的适用

性的声明或担保。 Microchip 对因这些信息及使用这些信息而

引起的后果不承担任何责任。如果将 Microchip 器件用于生命

维持和 / 或生命安全应用，一切风险由买方自负。买方同意在

由此引发任何一切伤害、索赔、诉讼或费用时，会维护和保障

Microchip 免于承担法律责任，并加以赔偿。在 Microchip 知识

产权保护下，不得暗中或以其他方式转让任何许可证。

请注意以下有关 Microchip 器件代码保护功能的要点：

• Microchip 的产品均达到 Microchip 数据手册中所述的技术指标。

• Microchip 确信：在正常使用的情况下， Microchip 系列产品是当今市场上同类产品中最安全的产品之一。

• 目前，仍存在着恶意、甚至是非法破坏代码保护功能的行为。就我们所知，所有这些行为都不是以 Microchip 数据手册中规定的

操作规范来使用 Microchip 产品的。这样做的人极可能侵犯了知识产权。

• Microchip 愿与那些注重代码完整性的客户合作。

• Microchip 或任何其他半导体厂商均无法保证其代码的安全性。代码保护并不意味着我们保证产品是 “牢不可破”的。

代码保护功能处于持续发展中。 Microchip 承诺将不断改进产品的代码保护功能。任何试图破坏 Microchip 代码保护功能的行为均可视

为违反了《数字器件千年版权法案 （Digital Millennium Copyright Act）》。如果这种行为导致他人在未经授权的情况下，能访问您的

软件或其他受版权保护的成果，您有权依据该法案提起诉讼，从而制止这种行为。
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前言
简介

此文档旨在帮助 PIC32 的新用户对 PIC32 架构的硬件和软件有一个基本了解，以快速
开始 PIC32 产品的软件开发。

此文档主要是为那些想对 PIC32 单片机以及由 Microchip 和第三方工具合作伙伴提供
的相关技术有一个概括了解的用户撰写的。如果您计划遵守此文档中后续部分提供的
逐步指导，需要对嵌入式系统开发和 C 编程知识有一个基本了解。

本章包含使用 PIC32 前需要了解的有用的一般信息。内容包括：

• 文档编排

• 本指南中使用的约定

• 推荐读物

• Microchip 网站

• 开发系统变更通知客户服务

• 客户支持

• 文档版本历史

客户须知

所有文档均会过时，本文档也不例外。 Microchip 的工具和文档将不断演变以满足客户的需求，因此
在实际使用中有些对话框和 / 或工具的说明可能与本文档所述之内容有所不同。请访问我们的网站
（www.microchip.com）获取最新文档。

文档均标记有 “DS”编号。该编号出现在每页底部的页码之前。 DS 编号的命名约定为
“DSXXXXXA”，其中 “XXXXX”为文档编号，“A”为文档版本。

欲了解开发工具的最新信息，请参阅 MPLAB® IDE 在线帮助。从 Help （帮助）菜单选择 Topics
（主题），打开现有在线帮助文件列表。
 2008 Microchip Technology Inc. DS61146B_CN 第 1 页
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文档编排

此文档分为 6 章。第 1 至 4 章给出了 PIC32 产品的概述。第 5 章给出了 PIC32 开发工
具的概述。第 6 章说明了安装开发环境和调试应用程序样本的步骤。本手册的内容编
排如下：

• 第 1 章 PIC32 功能

• 第 2 章 PIC32 产品系列

• 第 3 章 PIC32 架构

• 第 4 章 PIC32 工具

• 第 5 章 安装、编译和运行演示项目的逐步指导

• 第 6 章 技术支持资源
DS61146B_CN 第 2 页  2008 Microchip Technology Inc.
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本指南中使用的约定

本手册采用以下文档约定：

文档约定

说明 涵义 示例

Arial 字体：

斜体字 参考书目 MPLAB® IDE User’s Guide
需强调的文字 ... 仅有的编译器 ...

首字母大写 窗口 Output 窗口

对话框 Settings 对话框

菜单选项 选择 Enable Programmer
引号 窗口或对话框中的字段名 “Save project before build”
带右尖括号且有下划线的斜体
文字

菜单路径 File>Save

粗体字 对话框按钮 单击 OK
选项卡 单击 Power 选项卡

N‘Rnnnn verilog 格式的数，其中 N 指
数字的总数， R 为基数， n 是
一个数字。

4‘b0010, 2‘hF1

尖括号 < > 括起的文字 键盘上的按键 按 <Enter>， <F1>
Courier New 字体：

常规 Courier New 源代码示例 #define START

文件名 autoexec.bat

文件路径 c:\mcc18\h

关键字 _asm, _endasm, static

命令行选项 -Opa+, -Opa-

位值 0, 1

常数 0xFF, ‘A’

斜体 Courier New 可变参数 file.o，其中 file可以是任
一有效文件名

方括号 [ ] 可选参数 mcc18 [options] file 
[options]

花括号和竖线
字符： { | }

选择互斥参数；“或”选择 errorlevel {0|1}

省略号 ... 代替重复文字 var_name [, 
var_name...]

表示由用户提供的代码 void main (void)
{ ...
}

 2008 Microchip Technology Inc. DS61146B_CN 第 3 页
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推荐读物

本用户指南描述了如何使用 PIC32。下面列出了其他有用的文档。以下 Microchip 文
档均已提供，并建议读者将它们作为补充参考资料。

PIC32MX 自述文件 （Readme）
有关使用 PIC32 单片机的最新信息，请阅读相应的文件 （ASCII 文本文件），该文件
位于 PIC32 入门工具包中包含的 CD 的根目录下。自述文件通常包含了最新的更新信
息以及本文档发布时尚未出现但目前已知的问题。

自述文件

有关使用其他工具的最新信息，请参阅与该工具相关的自述文件，文件位于 PIC32MX
入门工具包安装目录的 Readmes子目录下。自述文件包含更新信息以及本文档发布时
尚未出现但目前已知的问题。

MICROCHIP 网站

Microchip 网站 （www.microchip.com）为客户提供在线支持。客户可通过该网站方便
地获取文件和信息。只要使用常用的因特网浏览器即可访问，网站提供以下信息：

• 产品支持——数据手册和勘误表、应用笔记和样本程序、设计资源、用户指南以及
硬件支持文档、最新的软件版本以及存档软件

• 一般技术支持——常见问题 （FAQ）、技术支持请求、在线讨论组以及 Microchip
顾问计划成员名单

• Microchip 业务——产品选型和订购指南、最新 Microchip 新闻稿、研讨会和活动
安排表、 Microchip 销售办事处、代理商以及工厂代表列表
DS61146B_CN 第 4 页  2008 Microchip Technology Inc.
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开发系统变更通知客户服务

Microchip 的客户通知服务有助于客户了解 Microchip 产品的最新信息。注册客户可在
他们感兴趣的某个产品系列或开发工具发生变更、更新、发布新版本或勘误表时，收
到电子邮件通知。

欲注册，请登录 Microchip 网站 www.microchip.com，点击 “变更通知客户”
（Customer Change Notification）服务并按照注册说明完成注册。

开发系统产品分类如下：

• 编译器——Microchip C 编译器及其他语言工具的最新信息。包括 MPLAB C18 和
MPLAB C32 C 编译器以及 MPLAB LIB30 目标库管理器。

• 仿真器——Microchip 在线仿真器的最新信息。包括 MPLAB ICE 2000 和 MPLAB 
ICE 4000。

• 在线调试器——Microchip 在线调试器 MPLAB ICD 2 的最新信息。

• MPLAB® IDE——用于开发系统工具的 Windows® 集成开发环境 Microchip 
MPLAB IDE 的最新信息。主要针对 MPLAB IDE、 MPLAB SIM 软件模拟器、
MPLAB IDE 项目管理器以及一般编辑和调试功能。

• 编程器——Microchip 编程器的最新信息。包括 MPLAB PM3 和 PRO MATE® II 器
件编程器以及 PICSTAR® Plus、 PICkit® 1 和 PICkit® 2 开发编程器。

客户支持

Microchip 产品的用户可通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师 （FAE）
• 技术支持

客户应联系其代理商、代表或应用工程师 （FAE）寻求支持。当地销售办事处也可为
客户提供帮助。本文档后附有销售办事处的联系方式。

也可通过 http://support.microchip.com 获得网上技术支持。

文档版本历史

版本 A （2007 年 10 月）

• 本文档的初始发行版。

版本 B （2008 年 3 月）

• 更新版。
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第 1 章  PIC32 功能
1.1 引言

PIC32 是 Microchip Technology 的 32 位通用单片机系列。它带有各种片内外设，且
可以提供 80+ DMIPS 的性能。 它采用了 MIPS Technologies, Inc 的业内领先的 M4K 
MIPS32 内核。 PIC32 系列的所有产品均采用了与 Microchip 的其他 PIC® 单片机类
似的编程界面。 此外，PIC32 单片机在引脚上与 16 位单片机 PIC24FJ128GA 系列兼
容。

1.2 重点

PIC32 系列提供了许多功能来帮助实现各种应用。 接下来的子章节列出了以主目录形
式编组的所有重要功能。

性能：

• 带 5 级流水线、工作频率最高 80 MHz 的 MIPS M4K 32 位内核　

• 高性能硬件乘法／除法单元——每个时钟执行一次乘法

• 将可编程用户存储区和内核存储区划分开来用于增强应用程序稳定性

• 用来减少中断响应延时的多个寄存器组

• 由硬件支持的单周期寄存器位操作

• 128 位宽的闪存，可缩短单个指令的取指时间

• 具有指令和 ROM 数据预取缓冲器的 256 字节高速缓存

• 具有集成的 CRC 计算功能和基于模式的传输终端选择功能的 DMA 控制器

• 包含适用于 USB 设备、主机或双角色应用的 USB On-The-Go 控制器

• USB 控制器具有专用的 DMA 接口

功耗管理：

• 在 2.3 至 3.6V 的电压下工作

• 在整个工作电压范围内全速工作

• 包括运行、空闲和休眠模式在内的各种低功耗模式

• 空闲模式下通过 DMA 实现 I/O 传输

• 可编程外设时钟

• 每个外设均可在空闲模式下单独实现启动／关闭控制，并可在空闲模式下工作

• 多个时钟源

可扩展性：

• 带 5 级流水线的 M4K CPU 内核与业界周知的 MIPS32 内核兼容

• 系列中具有很多器件，闪存容量从 32 KB 到 512 KB 不等

• 引脚与 64/100 引脚的 16 位单片机 PIC24FJXXXGA 系列兼容
 2008 Microchip Technology Inc. DS61146B_CN 第 7 页
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易于使用：

• PIC® 单片机 “可感观”外设

• 标准 MPLAB® 工具包——MPLAB IDE、 MPLAB C32 C 编译器、 MPLAB REAL 
ICE™ 和 MPLAB ICD 2。

• 软件外设函数库与 Microchip 16 位单片机的软件外设函数库兼容

• Microchip 开发的中间件模块，例如 TCP/IP 和 16 位文件系统
DS61146B_CN 第 8 页  2008 Microchip Technology Inc.
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第 2 章  PIC32 产品系列
2.1 引言

PIC32 系列包括了闪存范围从 32 KB 到 512 KB 的可扩展器件。同时还带有丰富的外
设集——五个定时器、 16 路通道的 10 位 A/D 转换器以及通信接口： SPI、 I2C™ 和
UART。
请查阅 “PIC32MX Family Data Sheet”（DS61143A），以获取关于器件系列的型
号、内核和外设特性的完整列表。

图 2-1： PIC32 MCU 模块
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RAMRAM

128128--bitbit
FlashFlash

CC
aa
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hh
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VectoredVectored
InterruptsInterrupts

BusBus
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DebugDebug

USBUSB
OTGOTG
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EUARTEUART
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第 3 章  PIC32 架构
3.1 引言

PIC32 系列 MCU 器件将 MIPS M4K 内核与功能强大的外设以及嵌入式闪存和 RAM 存
储器结合在一起，以满足各种应用的需要。

图 3-1： PIC32 框图

UART 1,2

比较器

Timer2 RTCC 10 位 ADCTimer3

PORTA(1)(4)

PORTD(1)

PORTE(1)

PORTF(1)
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PORTB

注 1： 图中引脚或特性并非在所有器件引脚配置中都能实现。

2： 一些功能在某些器件型号中没有实现。

3： 使能片上稳压器时可提供 BOR 功能。

4： PORTA 在 64 引脚器件中不存在。
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处理器内核：

• 带 5 级流水线的 MIPS M4K
• 指令集符合 MIPS32 的第 2 版

• MIPS16e™ 代码压缩最多 40%，可增大代码密度

• GPR 影子寄存器，可最大程度地减少中断处理程序的延时

• 位域操作指令

• 高性能乘法／除法单元：

- 每个时钟周期最多可执行一次 32 x 16 乘法

- 每隔一个时钟周期最多可执行一次 32 x 32 乘法

• 静态实现： 最小工作频率为 0 MHz
• 在整个工作电压范围 （2.3 至 3.6 V）内全速工作

• 包括运行、空闲和休眠模式在内的低功耗工作模式

存储器：

• 统一的 4 GB 虚拟存储空间

• 固定存储器映射转换 （Fixed Memory Mapping Translation， FMT）机制

• 为了增强应用程序的稳定性，可将存储器灵活分割为内核存储区和用户可访问存
储区

预取缓存：

• 16 行 （每行 128 位宽）指令预取缓冲器

• 具有装入和锁定行的功能——有利于在闪存中创建 SW 断点以及最大程度地减少
中断延时

中断控制器：

• 带单向量或多向量模式的完全可编程中断控制器，支持最多 95 个 IRQ
• 每个向量可设置多个优先级或次优先级

• 最高优先级中断具有一组专用寄存器，用于减少中断延时

DMA 控制器：

• 最多 4 路独立通道

• 可实现存储器到存储器、存储器到外设以及外设到存储器的传输

• 任一 IRQ 的可编程触发

• 可连接通道，并在检测到匹配时停止传输，具有自动使能模式

• 在内核处于空闲模式时仍可进行数据传输

• 集成的可编程 CRC 引擎： 可在数据传输时执行动态计算

增强的并行主端口：

• 8 位和 16 位数据接口

• 最多 16 位地址线，可使用 GPIO 线对其进行扩展

• 2 条片选线
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通信通道：

• 兼容 USB 2.0 （FS. 12 Mbps），可工作在 OTG、主机和仅设备模式

• 2 路带硬件 IrDA® 的增强型 UART 通道

• 2 路主／从／帧模式 SPI 通道

• 2 路主／从 I2C 通道，采用 10/7 位寻址模式，具有广播功能

模数转换器：

• 最多 16 路通道，每个通道提供 10 位分辨率的 ADC 输出

• 转换速度最高为每秒采样 500000 次 （即 500 ksps）
• 可用软件选择的内部或外部参考电压

• 自动通道扫描模式

• 可选择的转换触发源

• 16 字转换结果缓冲器

• 可选择的缓冲器填充模式

• 八种结果对齐选项

• 可工作在 CPU 休眠模式下

定时器：

• 5 个 16 位定时器／计数器，可构成最多两个 32 位定时器／计数器

• 可用软件选择的内部或外部时钟源

• 带内置振荡器的异步定时器／计数器

• 可编程中断发生和优先级

• 门控外部脉冲计数器

• 可通过软件选择的预分频器

• 可工作在 CPU 休眠模式下

内核定时器：

• CPU 自带一个 32 位定时器，用于实现定时器中断功能。

RTCC （实时时钟和日历）：

• 时间由小时、分和秒值表示

• 日历由星期、日、月和年值表示

• 闰年检测

• 可高度配置的闹钟

• 校准精度最高为晶振误差的 260 ppm

调试和编程：

• 6 条指令和 2 个数据断点

• 2 个复杂断点逻辑模块，带限定／预定断点触发逻辑、次数计数器和跑表定时器

• 4 线 EJTAG 和 2 线 Microchip 接口

• 2 线 Microchip 接口：

- 6 个实时读／写捕捉逻辑模块

- 无需停止 CPU 就可读写所有数据 RAM 和 SFR
• 指令跟踪端口：

- 5 线非抢占式跟踪端口

- 由复杂断点逻辑模块触发
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GPIO：

• 可经受 5 V 输入

• 可单独使能／禁止输出引脚的漏极开路

• 可单独使能／禁止输入引脚的弱上拉

• 监视选择性引脚并在检测到不匹配的情况下产生中断

注： 输入引脚弱上拉和不比配时发生中断的特性仅适用于选定的 I/O 引脚。
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第 4 章  PIC32 工具
4.1 引言

PIC32 单片机受 MPLAB 集成开发环境及可在该环境下使用的所有硬件和软件工具
支持。

4.2 重点

本章讨论的内容有：

• MPLAB IDE
• MPLAB C32 C 编译器

• 外设函数库

• 软件解决方案

• 演示、开发和评估板

• 技术文档

4.3 MPLAB IDE
Microchip MPLAB IDE 是基于 Microsoft Windows® 操作系统的免费开发工具包，它包
括：

• 到所有调试工具的单个图形界面：

- 软件模拟器

- 编程器

- 仿真器

- 在线调试器

• 用颜色区分代码的全功能编辑器

• 项目管理器

• 可直接编辑内容的自定义数据窗口

• 高级源代码调试功能

• 丰富的在线帮助

MPLAB IDE 通过使用以下任一连接设备连接到目标处理器／开发板，来提供集成的调
试和编程功能：

• MPLAB ICD 2 在线调试器：一种低成本的运行时开发工具。

• MPLAB REAL ICE 在线仿真器：一种具有硬件和软件跟踪功能的高速在线仿真
器。

• FS2 JTAG 探头：由 First Silicon Solutions 开发的这种探头采用了 4 线 EJTAG 接
口来调试和编程 PIC32 单片机。

• MPLAB PM3 器件编程器：一种用于开发和生产用途的 Microchip 通用器件编程
器。

• MPLAB SIM32 器件模拟器：在可选的周期和精确时钟模式下可精确模拟许多
PIC32 外设和 CPU
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4.4 MPLAB C32 C 编译器

MPLAB C32 C编译器软件包允许您编译应用程序，它包含以下重要软件组件（见图 4-1）。
• PIC32-gcc 编译器：这是一个具有强大的集成功能和有效的代码优化功能的完整

ANSI C 编译器。该编译器提供了 MPLAB IDE 调试器使用的符号信息。

• PIC32-gpp 宏处理器：编译器在编译前自动使用该宏处理器转换程序。

• PIC32-as 汇编器：全功能宏汇编器。

• PIC32-ld 目标链接器：将汇编器／编译器创建的可重定位对象与预编译库中的对
象进行链接。

• PIC32-ar 归档器和库管理器：管理预编译代码的库文件的创建和修改。

• PIC32-conv：将 ELF 可执行文件转换为 ASCII 或二进制格式，适合于下载到
PROM 编程器或评估板。

图 4-1： MPLAB® IDE 开发工具组件

MPLAB® IDE 文本编辑器

 MPLAB IDE 编译器

  MPLAB IDE 汇编器

　 MPLAB IDE
 宏处理器

MPLAB IDE 链接器 MPLAB IDE 归档器

　 库

  MPLAB IDE 转换器
  MPLAB IDE 调试器

MPLAB ICD 2 仿真器／
     编程器

  

 MPLAB IDE 软件模拟器

（PIC32-gcc）
（PIC32-cpp）

（PIC32-ar） （PIC32-ld） （PIC32-as）

（PIC32-conv）

    仿真器／编程器

MPLAB REAL ICE
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4.5 外设函数库

PIC32 MCU 集成了大量的片内高性能外设。

为了加快对这些外设的使用， PIC32 的 MPLAB C32 编译器包括了与 16 位 Microchip 
MCU 兼容的软件外设函数库。该外设函数库以源代码和目标格式提供，并附有详细的
API 描述文档。使用 MPLAB C32 编译器的软件应用程序可以通过简单地将相应的头文
件包含在源文件中来调用外设库函数——MPLAB C32 编译器具有内置的库头文件和归
档文件的信息。

外设头文件及其完整源代码分别位于相应的外设子目录 C:\Program Files 
\Microchip\MPLAB C32\pic32mx \include\peripheral和 C:\Program 
Files\Microchip\MPLAB C32\pic32-libs\peripheral下。

外设函数库包含以下头文件：
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表 4-1： 外设函数库

外设 头文件 说明

ADC adc10.h 用于模数转换器支持的库

存储器配置 bmx.h 用于配置总线矩阵内部总线、优先级和存储器布局的库

模拟比较器 cmp.h 用于比较器模块支持的库

比较器参考电压 cvref.h 用于比较器参考电压支持的库

DMA 控制器 dma.h 用于 DMA 控制器和 CRC 模块支持的库

非易失性 （闪存）

存储器

nvm.h 提供擦除／编程闪存功能的库

I2C™ i2c.h 用于 I2C™ 模块支持的库

输入捕捉 incap.h 用于输入捕捉模块支持的库

中断 int.h 用于向量中断控制器支持的库

锁定 lock.h 用于系统锁定和解锁支持的库

输出比较 outcompare.h 用于输出比较模块支持的库

振荡器 osc.h 用于振荡器支持的库

预取高速缓存 pcache.h 用于预取高速缓存模块支持的库

功耗模式 power.h 用于休眠和空闲功耗模式支持的库

并行主端口 pmp.h 用于并行主端口支持的库

GPIO ports.h 用于配置 I/O 端口、读或写 I/O 数据的库

复位 reset.h 用于复位控制和状态的库

RTCC rtcc.h 用于实时时钟和日历支持的库

SYSTEM system.h 用于系统级操作的库

SPI spi.h 用于串行外设接口支持的库

定时器 timer.h 用于支持 16 位和 32 位定时器的库

UART uart.h 用于支持增强型 UART 模块的库

看门狗 wdt.h 用于支持看门狗定时器模块的库
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4.6 软件解决方案

在撰写此文档时， Microchip 尚未发布任何驱动程序。 Microchip 正打算为重要通信外
设开发驱动程序。

4.6.1 中间件

以下列表提供了在撰写此文档时可用的 Microchip 中间件组件：

• SD 存储器上的 16 位文件系统，可支持 Microsoft MS-DOS 文件系统。

• 两种类型的 TCP/IP 协议栈——1)Microchip 传统 TCP/IP 协议栈——与 Microchip  8
位和 16 位栈完全兼容， 2)Microchip BSD TCP/IP 协议栈——具有许多高级功能的
Berkeley 套接字 API 栈。

• TCP/IP 中间件：

- FTP 服务器允许应用程序在目标 PIC32 机器上运行，使其成为一台文件传输
协议服务器。

- SNMP 代理使用 SNMP 协议监视 PIC32 产品。

- 网络服务器接受来自 Web 浏览器客户端的 HTTP 请求。

• USB 中间件：

- USB 嵌入式主机栈 （HID 和海量存储）

- USB 设备栈 （HID、海量存储和 CDC 类）

4.6.2 第三方工具

查看 PIC32 主页 （www.microchip.com/PIC32）以获得关于支持 PIC32 的公司列表。
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4.7 演示、开发和评估板

PIC32 MCU 的各种演示、开发和评估板允许快速开发全功能系统应用。这些板中的大
部分板都包括可添加自定义电路的实验布线区，并提供用于实验和修改的应用程序固
件和源代码。这些电路板可支持各种功能，包括 LED、开关、 RS-232 接口，以及
LCD 显示屏等等。演示和开发板可用于教学环境、试验自定义电路以及对各种单片机应
用程序的学习。

目前已提供以下电路板：

1. PIC32MX 入门工具包 （DM320001）。

2. 带 PIC32 接插模块的 Explorer 16 开发板（DM240001）。

4.8 技术文档

针对 PIC32 MCU 的当前可用文档有：

• 应用笔记：

- AN833，《Microchip TCP/IP 协议栈》（DS00833B_CN）

- AN1107，“HTTP Server for the Microchip BSD TCP/IP Stack”（DS01107）
- AN1108，“Microchip TCP/IP Stack with BSD Socket API”（DS01108）
- AN1109，“An SNMP Agent for the Microchip TCP/IP Stack”（DS01109）
- AN1111，“The Microchip FTP Server Using BSD Socket API”（DS01111）
- AN1140，“USB Embedded Host Stack”（DS01140）
- AN1141，“USB Embedded Host Stack Programmer’s Guide”（DS01141）
- AN1142，“USB Mass Storage Class on an Embedded Host”（DS01142）
- AN1143，“USB Generic Client on an Embedded Host”（DS01143）
- AN1144，“USB HID Class on an Embedded Host”（DS01144）
- AN1145，“Using a USB Flash Drive on an Embedded Host”（DS01145）
- AN1176，“USB Devcie Stack for PIC32 Programmer’s Guide”（DS01176）
- AN1166，“USB Generic Function on an Embedded Device”（DS01166）
- AN1163，“USB HID Class on an Embedded Device”（DS01163）
- AN1169，“USB Mass Storage Class on an Embedded Device”（DS01169）
- AN1164，“USB CDC Class on an Embedded Device”（DS01164）

• 数据手册：

- DS61143——PIC32MX Family Data Sheet
• 系列参考手册：

- DS61132—— PIC32MX Family Reference Manual
• 代码示例：

- PIC32 代码示例可从 C:\ProgramFiles\Microchip\MPLAB C32\examples
和 www.microchip.com/pic32 获得。

• 勘误表 （DS80350 和 DS80367）
• 移植文档——将来提供

• 设计笔记、技巧和诀窍——将来提供

• 开发工具订购指南——将来提供
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第 5 章  安装、编译和运行演示项目的步骤
5.1 引言

在本步骤中，将介绍 MPLAB 项目管理器、编辑器和调试器的基本概念。您将创建一个
简单的项目并了解 MPLAB IDE 的调试功能。

我们前面没有介绍过关于 MPLAB IDE 的知识。更多关于 MPLAB IDE 及其组件的完整
功能集和综合的技术详细信息，请访问我们的网站 （www.microchip.com/ide）。

5.2 重点

本章讨论的内容包括：

• MPLAB IDE 安装

• 逐步指导概述

• 选择器件

• 创建项目

• 设置语言工具

• 为项目命名

• 将文件添加到项目

• 连接到调试器

• 编译项目

• 测试代码

5.3 MPLAB IDE 安装

5.3.1 安装 MPLAB IDE
要在您的系统上安装 MPLAB，您可以使用提供的安装光盘，或者从 Microchip 网站上
下载最新的 MPLAB IDE。

- 要从 CD-ROM 安装，只要将光盘插入光驱并按照屏幕上的提示进行操作即可
（您可以使用 Windows 资源管理器找到并执行 CD-ROM 菜单 menu.exe）。

- 如果 MPLAB IDE 是从 Microchip 网站上下载的，则解压文件并执行解压后的
文件来进行安装。

5.3.2 卸载 MPLAB IDE
- 选择开始 > 设置 > 控制面板，以打开控制面板。

- 双击添加／删除程序。找到 MPLAB IDE，并将它选中。

- 单击更改／删除，以将程序从您的系统中删除。

注： 在个人计算机上安装 MPLAB 需要有管理员访问权限。

注： 卸载 MPLAB 可能需要有管理员访问权限。
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5.3.3 运行 MPLAB IDE
要启动 MPLAB IDE，双击安装后安装在桌面上的图标或选择开始 > 程序 >Microchip> 
MPLAB IDE vx.xx>MPLAB IDE。则屏幕上会出现 MPLAB IDE 徽标并随后显示
MPLAB IDE 桌面。

图 5-1： MPLAB IDE 启动屏幕

5.4 逐步指导概述

要创建可由 PIC32 MCU 执行的代码，项目中需要包括源文件。然后使用选定的语言工
具（汇编器、编译器和链接器等）将这些代码编译成可执行代码。在 MPLAB IDE 中，
项目管理器控制该过程并指导我们完成这些步骤中的大部分步骤。

所有项目都将经历这些基本步骤：

- 选择器件

MPLAB IDE 的功能根据选定器件的不同而有所变化。器件选择应该在创建项目之前完
成。

- 创建项目

将使用 MPLAB IDE Project Wizard （项目向导）来创建项目。

- 选择语言工具

在 Project Wizard 中选择语言工具。在此教程中，将使用 PIC32 工具。对于其他项
目，可选择 Microchip 的其他工具或第三方工具。

- 将文件添加到项目

将添加一个模板文件和一个链接描述文件到项目。

- 创建代码
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一些非常简单的代码将添加到模板文件中，以向连接到评估板的串行控制台打印输出
“Hello World…”字符串。我们将使用 Microchip 提供的 UART 外设函数库。

- 编译项目

项目将被编译——即源代码被编译并链接成可在选定的 PIC32 MCU 上运行的机器码。

- 测试代码

最后，通过在评估版上运行代码来执行测试。

5.5 选择器件

从 IDE 顶层菜单中选择 Configure>Select Device。在 Select Device （器件）对话框
中，从下拉列表中选择所需的 PIC32 器件。

图 5-2： MPLAB IDE SELECT DEVICE 对话框

这些灯指示哪种 MPLAB IDE 组件支持此器件。

- 绿灯表示完全支持。

- 黄灯表示由特定的 MPLAB IDE 工具组件初步支持的即将发布的器件。显示黄
灯而不是绿灯的组件通常是针对需要快速支持并理解某些操作或功能不可用的
新器件的早期使用者而开发的。

- 红灯表示不支持此种器件。对于该工具的支持目前暂未提供，或者当前提供的
支持不适合该工具。

注： 用户界面的某些方面在以后的产品发布中会进行更改，因此本指南中的屏
幕快照可能会与以后版本中 MPLAB IDE 桌面的外观不完全相同。
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5.6 创建项目

下一步是使用 Project Wizard 创建项目。项目是指对文件进行组织并对其执行编译、
汇编和链接操作的方法。我们将使用一个用于创建项目的 C文件与一个链接描述文
件。

选择 Project>Project Wizard。
从 Welcome （欢迎）对话框中，单击 Next> 继续。

Step One （第一步）对话框允许您选择器件 （已选定）。确保屏幕中显示的是正确的
PIC32 器件。如果不是，从下拉菜单中选择所需的 PIC32 器件。单击 Next>。

图 5-3： MPLAB IDE 向导选择器件
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安装、编译和运行演示项目的步骤
5.7 设置语言工具

Project Wizard 的第二步是设置此项目使用的语言工具。确保选中“Show all installed 
toolsuites”（显示所有已安装的工具包）复选框。在 Active Toolsuite （活动工具包）
列表框中选择 “Microchip PIC32 C Compiler Toolsuite”（Microchip PIC32 C 编译器
工具包）。

然后在 Toolsuite Contents （工具包组件）框中应看到 “MPLAB PIC32 Assembler 
(PIC32-as.exe)”、“MPLAB PIC32 C Compiler (PIC32-gcc.exe)”、“MPLAB PIC32 
Object Linker (PIC32-ld.exe)”和 “MPLAB PIC32 Archiver (PIC32-ar.exe)”。单击每
个选项查看它的存储位置。如果 MPLAB IDE 安装在默认目录下，则这些文件的路径
为：

• 对于 MPLAB PIC32 汇编器：

- C:\Program Files\Microchip\MPLAB IDE\ MPLAB C32\bin 
\PIC32-as.exe

• 对于 MPLAB PIC32 编译器：

- C:\Program Files\Microchip\MPLAB IDE\ MPLAB C32\bin\ 
PIC32-gcc.exe

• 对于 MPLAB PIC32 目标链接器：

- C:\Program Files\Microchip\MPLAB IDE\ MPLAB C32\bin 
\PIC32-ld.exe

• 对于 MPLAB PIC32 归档器：

- C:\Program Files\Microchip\MPLAB IDE\ MPLAB C32\bin 
\PIC32-ar.exe

如果这些路径未正确显示，使用 Browse （浏览）按钮将它们设置为 MPLAB IDE 子
文件夹下的相应文件。

完成后，点击 Next>。

图 5-4： MPLAB IDE 选择语言工具包
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5.8 为项目命名

向导第三步允许您为项目命名并将其存放到相应的文件夹内。该示例项目将命名为
MyTestProject。使用 Browse 按钮，将项目存放在名为 Projects32 的文件夹中。单击
Next>。

图 5-5： MPLAB IDE 为项目命名
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5.9 将文件添加到项目

Project Wizard 的第四步允许为项目选择文件。这是我们能够将现有文件添加到项目的
地方。在当前示例中，我们没有事先创建好的文件，但是一旦完成了新项目设置，我
们就创建了一个文件。

只要按下 Next> 按钮就会出现 Summary （总结）屏幕：

图 5-6： MPLAB IDE SUMMARY 屏幕

按下 Finish （完成）将显示一个工作区对话框：

图 5-7： MPLAB IDE 保存工作区
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确保将工作区保存在 Projects32 目录下并使用与项目 MyTestProject 相同的名字对该
工作区进行命名。

单击 Save （保存）。

现在项目空间已创建完毕，它应该看起来如下：

图 5-8： MPLAB IDE 保存项目

现在我们创建了一个 C 源文件。如果 MPLAB IDE 编辑器窗口没有打开，从顶层菜单
中单击 File->New 或单击标准工具栏上的 New File （新建文件）菜单快捷按钮。将弹
出编辑器窗口。

我们在编辑器窗口中键入非常简单的 Hello World 程序，将它保存在 Projects32 目录下
并命名为 main.c。我们将使用由 Microchip 提供的 UART 外设函数库：
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安装、编译和运行演示项目的步骤
图 5-9： MPLAB IDE MAIN.C 文件

要将新建的 main.c文件添加到我们的项目中，只要右击 MPLAB IDE MyTestProject.mcp
窗口内的 Source Files 文件夹并选择 Add File （添加文件）。浏览并从 Projects32 目录下
选择 main.c文件。

MPLAB IDE 自动选择此项目需要的链接描述文件。不需要添加任何其他文件到我们的
项目中。

注： 如果项目窗口没有打开，从 IDE 顶层菜单选择 View->Project。
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在 MyTestProject.mcp 窗口中右击并选择 Save。测试项目应该被保存。
MyTestProject.mcp 应看起来如下：

图 5-10： 保存后的 MPLAB IDE 项目

提示：在项目窗口中右击鼠标可以添加文件和保存项目。如果出错，可以选择出错文
件并使用右键菜单将其手动删除。
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安装、编译和运行演示项目的步骤
5.10 连接到调试器

要使用 PIC32 入门工具包测试代码，请参见 《PIC32MX 入门工具包用户指南》
（DS61144B_CN）中的示例项目和逐步入门信息。

为了测试文档使用的代码，我们将使用一个 Explorer 16 开发板 （DM240001）、一
个 MPLAB REAL ICE 在线调试器 （DV244005）和一个 PIC32MX360F512L PIM
（MA320001）以及一个 9V 的通用电源、一根 USB 电缆和一根用于将 REAL ICE 连
接到开发板的串行电缆。

图 5-11：        EXPLORER 16、 MPLAB® REAL ICE™ 和 PIC32MX360F512L PIM

执行以下步骤以确保 REAL ICE 与 Explorer 16 开发板正确连接：

1. 使用 USB 电缆将 MPLAB REAL ICE 模块与 PC 连接。

2. 使用短 RJ-11 电缆将 MPLAB REAL ICE 与 Explorer 16 开发板连接。

3. 给 Explorer 16 开发板供电。

4. 在 MPLAB IDE 中，从 Debugger （调试器） 菜单中单击 Select Tool > MPLAB 
REAL ICE，以将 MPLAB REAL ICE 选为调试工具。

5. 从 Debugger 菜单选择 Connect，以将调试器与器件连接。 MPLAB IDE 应该在
Output 窗口中报告它找到了 PIC32MX360F512L 器件。

在执行了这些步骤之后，转到 MPLAB IDE 窗口，并从 Debugger->Select Tool 菜单中
选择用来与开发板连接的调试工具 （即， MPLAB REAL ICE 应该在选择范围内）。

选择了该工具后，“Debug 工具栏”（调试工具栏）应该和其他选定的工具栏一起显示
在主菜单工具栏下方。

注： 如果这是第一次将 MPLAB REAL ICE 与 PIC32 器件一起使用，那么
MPLAB IDE 可能需要下载新的固件。请允许 MPLAB IDE 下载。

注： 确保从 MPLAB IDE Build Configuration （MPLAB IDE 编译配置）下拉列
表中选择了 Debug。
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5.11 编译项目

从 Project （项目）菜单中可以编译和链接当前文件。

要编译项目，请执行以下任一方法：

- Project>Build All
- 在项目窗口中右击项目名称并选择 Build All （编译所有）

- 在 Project 工具栏中单击 Build All 图标。将鼠标悬停在图标上就会弹出代表图
标含义的文本。

Output 窗口显示编译结果。任一步骤都应该没有错误。

图 5-12： MPLAB IDE 项目编译

5.12 测试代码

首先通过从 Debugger 菜单中选择 Debugger->Program 或从 “Debug 工具栏”中直
接选择编程按钮，来下载我们刚编译的程序的 hex 映像。编程操作应该无错执行。

为了测试示例应用程序，还需要对 PC 进行设置。

使用一根串行电缆将开发板 RS-232 的连接头与 PC 的一个 COM 端口连接，然后在
PC 上打开超级终端应用程序 （程序 -> 附件 -> 通讯 -> 超级终端）。

为此连接选择一个合适的名字，单击 OK，然后在 “连接到”屏幕中选择连接有开发
板的 COM 端口。
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安装、编译和运行演示项目的步骤
图 5-13： 超级终端连接屏幕

单击 OK 并在下一屏幕中选择以下通信设置：

• 每秒比特数：57600
• 数据位：8
• 奇偶校验位：无

• 停止位：1
• 流控制：无

单击 OK，则超级终端会话应连接到开发板的串行端口上。

现在返回到 MPLAB IDE，双击代码行：

return nc;
在 MPLAB IDE 编辑器窗口中，会在 main.c程序的此行上设置一个断点，紧跟在对
函数 strlen()的调用之后。

从主菜单中单击 Debugger->Run 或从 Debug 工具栏中选择 Run （运行）。程序应该
开始运行，并在到达设置的断点处暂停。 MPLAB IDE 窗口将看起来与下图非常类似：
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图 5-14： MPLAB IDE 到达断点时的情形

1. 选定与演示板连接的调试工具

2. 目标板上选定的器件

3. Debugger 顶层菜单下的可用菜单

4. Debug 工具栏

5. Source （源代码）窗口，此时运行到断点处

6. Disassembly （反汇编）窗口

7. Output （输出）窗口

8. Program Memory （程序存储器）窗口

现在，如果看一眼 PC 的超级终端窗口，将看到我们的简单测试程序发送到串行连接
线上的输出结果：

图 5-15： 超级终端接收的字符

4

3

1

5

6

8

72
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安装、编译和运行演示项目的步骤
同时，如果看一下 Explorer 16 开发板，将看到 LED D9 点亮。

这表示 PIC32 Explorer16 演示板和 MPLAB IDE 正常工作。

我们仅仅演示了 PIC32 的第一个 “Hello World”程序。

在 MPLAB IDE 中还可以为调试程序做许多其他事情。例如，您可注意到将鼠标悬停在
变量 “nc”上会看到它的实际值 （这个值就是 putsUART2()函数应该发送到串行端
口的字符数）。

其他 MPLAB IDE 调试功能有：

• Watch （观察）窗口：可以将外设 SFR 的变量添加到 Watch 窗口并监视它们的值

• 复杂断点操作

• 所有有用的调试命令：step into （单步跳入）和 step over （单步跳过）等，都可
用在 C 源代码窗口和　disassembly listing （反汇编列表）窗口中。

• 配置代码执行并计算程序内不同断点之间的延迟时间。

在这里，我们介绍了使用 MPLAB IDE 开始使用 PIC32 的基本步骤。现在您已经准备
好继续探索 PIC32 和 MPLAB IDE 的功能。欲知有关 PIC32 的进一步信息，请参见本
文档中提供的文档清单。欲知更多有关 MPLAB IDE 的信息，请参见我们的网站上
（www.microchip.com）设计链接中提供的 《MPLAB IDE 快速入门指南》
（DS51281G_CN）。
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注：
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第 6 章  技术支持资源
6.1 引言

欲知关于提供的技术支持的信息，请访问网站 Support.microchip.com。
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